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Chapter 1: Introduction
Welcome to xMatters (IT Operations) for HP BSM Operations Manager i software. This document describes how to
install and configure the xMatters (IT Operations) for HP BSM Operations Manager i software software integration.
The intended audience for this document is experienced consultants, system administrators and other technical
readers.

1.1 Summary
xMatters is an interactive alerting application, designed to capture and enrich important events, to route those events
to the right person on any communication device, and to give that person the ability to solve, escalate, or enlist
others to resolve the events remotely.

xMatters allows you to take critical business information and contact the right people via voice phone, SMS, two-
way pagers, instant message, and email.

Through integration modules, xMatters can become the voice and interface of an automation engine or intelligent
application (the Management System, such as HP BSM Operations Manager i software). When HP OMi detects
something that requires attention, xMatters places phone calls, sends pages, messages, or emails to the appropriate
personnel, vendors or customers.

xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or
resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with HP
BSM Operations Manager i software. Responses are executed immediately on HP OMi, enabling remote resolution
of the event.

This integration supports event notifications (from HP OMi to xMatters) through the use of web service calls via the
xMatters integration agent. It also supports inbound actions (from xMatters to HP OMi) to update events remotely.

You will need to modify this configuration to suit your particular business requirements and adjust it to suit your
expected loads. For example, the default integration features automatic status annotations to the original event; in a
high-volume production system, this can significantly affect performance. Consider your expected volume of
injected events and your server capacity when designing your own integration with xMatters.

1.1.1 Benefits
With the xMatters integration, the appropriate technician can be notified directly via voice, email, pager,
BlackBerry, or other device. Information about the failure will be presented to the event resolver and decisions can
be made in real-time.

Once a response is selected on the recipient’s remote device, xMatters will update the HP OMi event in real-time.
The benefit is that this process is immediate – significantly faster than the time required for staff to notice the
failures or malfunctions, determine who is on call, and manually notify the right person. In addition, the ability to
take simple actions on the event from any device gives the event resolver a quick way to deal with many issues and
communicate to other team members the current state of the event.

During the process, every notification, response, and action is logged in xMatters. In addition, xMatters
automatically annotates the original event with status information.

The xMatters product features a self-service web user interface to allow accurate assignment of responsible personnel
for each job. xMatters also includes a Subscription panel that allows both managed and self-subscription to HP OMi
events.
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1.1.2 Information Workflow
The following diagram provides an example of a standard workflow in a network monitoring system, and how information
from the management system can be passed into xMatters (IT Operations) engine:

1.1.3 Integration Architecture
The software components in this integration include:

l xMatters (IT Operations) engine
l HP BSM Operations Manager i software
l xMatters integration agent

The following diagram illustrates the software processes used by this integration:

1.2 System Requirements
The following products must be installed and operating correctly prior to integration:
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l xMatters (IT Operations) engine 4.1 (patch 007 or later).
l xMatters integration agent 4.1 (patch 004 or later)
l xMatters Developer IDE
l HP BSM Operations Manager i software 9.10 GA (with Hotfix QCCR1A130360)

1.2.1 Operating Systems
The following operating systems are supported by this integration:

l Microsoft Windows 2008 64-bit (validated)

1.3 Conventions and Terminology
This section describes how styles are used in the document, and provides a list of definitions.

1.3.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,
and then click the Open menu option.

Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:

l text that must be typed into the computer
l directory and file names
l code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute
the given paths with the Unix equivalents.

The xMatters installation folder is referred to throughout the documentation as <xMHOME>.

l On Windows systems, the default is C:\Program Files\AlarmPointSystems\AlarmPoint\
l On Unix systems, the default is /opt/alarmpointsystems/alarmpoint/

The xMatters integration agent installation folder is referred to throughout the documentation as <IAHOME>.

l On Windows systems, the default is C:\Program Files\AlarmPointSystems\IntegrationAgent\
l On Unix systems, the default is /opt/alarmpointsystems/integrationagent

1.3.2 Terminology
The following terms are used through the xMatters documentation.
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Term Meaning

Event An event refers to any situation or item of interest detected by the management system, and which
requires attention. Event is also used to refer to the incident or situation as it progresses through the
xMatters system, from injection to notification to resolution. Each event must generate at least one
alert or notification.

Event can also be a generic term used to refer to an incident, change request, message, or other
specific item within the management system. Whenever possible, these situations are referred to
using the management system's preferred terminology, but can also collectively be called events.

Management system A management system is any sort of monitoring or managing software that watches for events, and
with which xMatters can combine; i.e., a synonym for HP OMi.

Device The medium through which a recipient is contacted by xMatters; i.e., email, pager, phone,
BlackBerry, etc.

User In xMatters, people who can receive notifications are called "Users". Each person in the xMatters
system is defined by a set of User details, including ID number, user name, login password, and so
on.

Group Groups are used to collect and organize Users and Devices into notification schedules. For a
complete explanation of Groups in xMatters, see the xMatters engine user guide.

Documentation terminology
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Chapter 2: Installation and Configuration
This chapter provides information about installing the xMatters (IT Operations) for HP BSM Operations Manager i software
integration. This chapter also contains complete instructions on how to configure xMatters, HP OMi, and the integration
components.

2.1 Installing the integration
The instructions in this chapter do not include information on how to install xMatters (IT Operations) engine, the xMatters
integration agent, or HP BSM Operations Manager i software. These components must be installed according to their related
documentation, and operating properly before you can proceed with the integration.

Note: For more information about installing xMatters (IT Operations) engine and other xMatters products, refer to the
xMatters web site at http:///www.xmatters.com.

2.1.1 Integration components
The following table describes some of the notable components in the integration archive file:

Component Name Description

hpomi.js Primary configuration file for the integration:

l Specifies web services communication settings between xMatters and HP OMi.
l Identifies which event details will be forwarded from HP OMi for xMatters to

use when creating notification content.

omi-config.js Contains connection information for HP OMi, and the web services root path with
which this integration communicates.

xM-HP-OMi.xml Event Domain package containing pre-configured Event Domain, Action scripts,
predicates, and Event Domain Constants.

Integration components

2.1.2 Installing the integration service and updating the integration agent
To configure the integration agent for the HP OMi integration, you must copy the integration components into the
integration agent; this process is similar to patching the application, where instead of copying files and folders one by one,
you copy the contents of a single folder directly into the integration agent folder (<IAHOME>). The folder structure is identical
to the existing integration agent installation, so copying the folder's contents automatically installs the required files to their
appropriate locations. Copying these files will not overwrite any existing integrations.

If you have more than one integration agent providing the "hpomi" service, repeat the following steps for each one. If you are
not certain of the settings required in this section, consult your HP OMi administrator.

Note: If you have already installed an existing integration, ensure that you backup the deduplicator-filter.xml file
(if one exists) in the <IAHOME>\conf folder before you install this integration. 

To install the integration service:

1. Copy all of the contents, including subfolders, of the xM-HP-OMi\components\alarmpoint-integration-agent\
folder from the extracted integration archive to the <IAHOME> folder.
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2. If you backed up an existing deduplicator file as indicated in the note above, merge the contents of your back up with
the newly installed <IAHOME>\conf\deduplicator-filter.xml file: open both files in a text editor, and then copy
the <filter> node from the backup file into the new deduplicator file after the last </filter> node. Save and close the
file.

3. Open the <IAHOME>\conf\IAConfig.xml file and add the following line to the “service-configs” section:
<path>hpomi/hpomi.xml</path>

4. Open the <IAHOME>\integrationservices\hpomi\omi-config.js file and modify the following variables:

Setting Description

OMI_SERVER To configure this setting, replace the default value of "localhost" with
the fully qualified DNS name of the HP OMi Gateway server. The
default value is:

localhost

OMI_PROTOCOL The protocol used for HP OMi connectivity; the default value is "http".
To enable SSL communication, replace the default value with "https".

OMI_PORT To configure this setting, replace the default value of "80" with the port
number of your HP OMi server.

OMI_USER Specifies the username of the web services client account to use when
connecting to the HP OMi web services; the default value is
"xMatters". Note that this user name is case-sensitive, and must match
the name of the defined connected server.

For more information, see "Creating a connected server" on page 10.

OMI_PASSWORD_FILE Specifies the location of the password file containing the web services
user's password; for instructions on how to set the password for this
user, see "Setting web services user password " on page 7, below.

OMI_REST_SYNC_EVENT_ROOTPATH Specifies the endpoint used to obtain more event details when an Opr
Event Change object is received; the default value is:
/opr-gateway/rest/synchronization/event/

OMI_REST_SYNC_EVENT_CHANGE_
ROOTPATH

Specifies the endpoint used to send Opr Event Change objects to HP
OMi, which reflect response choices made by xMatters Users and are
intended to update events accordingly; the default value is:
/opr-gateway/rest/synchronization/event_change/

DEDUPLICATOR_FILTER Specifies the name of the filter used by the integration agent's
deduplicator module, which prevents duplicate events from being
injected into xMatters; the default value is "hpomi".

Note that the deduplication filter is cleared whenever the integration
agent is restarted; this means that after a restart, events that would
otherwise be filtered may be injected into xMatters.

ANNOTATE_DELIVERY Specifies whether xMatters should update the originating event with
delivery annotations; the default value is "true".

5. Restart the integration agent.
l On Windows, the integration agent runs as a Windows Service; on Unix, it runs as a Unix daemon.
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Setting web services user password 
This integration includes a encrypted file, located in the <IAHOME>\conf folder, that stores the password for the management
system. You will need to update the file with the correct password for the OMI_USER specified in the omi-config.js file.

To specify a web service user password:

1. Open a command prompt, and then navigate to <IAHOME>\bin.
2. Run the following command, where <new_password> is the password for the web services user specified in the omi-

config.js file and <old_password> is the existing password (the default value for a newly installed integration is
"password").

iapassword.bat --new <new_password> --old <old_password> --file conf/hpomi.pwd

2.1.3 Installing voice files
These files must be installed into any xMatters deployment running a voice Device Engine. For more information, refer to the
xMatters installation and administration guide.

To install the voice files:

1. Copy all of the files in the xM-HP-OMi\components\alarmpoint\vox\english folder from the extracted integration
archive to the following node installs folder:

<xMHOME>\node\phone-engine\Datastore\domains\common\recordings\english\phrases

Note: This integration provides a complete set of English voice files.

2.2 Configuring xMatters
The following sections describe how to configure xMatters to combine with HP OMi.

2.2.1 Importing Event Domain and scripts
The integration package includes an XML file that was created using the xMatters "Export Integration" feature; this greatly
simplifies the xMatters configuration process by enabling you to create the integration Event Domain, configure the
predicates and Event Domain Constants, and import the integration script package in a single step.

Note: For a description of how to import the script package and configure the Event Domain manually, refer to
"Manually configuring xMatters" on page 16.

To import the integration Event Domain package:

1. Log in to xMatters as a Company Administrator, and click the Developer tab.
2. In the Domains menu on the left side of the screen, click Event Domains.
3. On the Event Domains page, click Import New.
4. On the Import Integration page, click Browse, and then locate the xM-HP-OMi.xml file extracted from the integration

archive.
5. Click Open, and then click Upload.

xMatters imports the integration configuration settings and displays the new hpomi Event Domain.
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Defining an Integration Service
For the installation to be successful, the integration service name must match the name specified in the hpomi.js file and
the IAConfig.xml file installed on the integration agent.

To define an Integration Service:

1. In xMatters, on the Event Domains page, click the hpomi Event Domain.
2. On the Event Domain Details page, in the Integration Services area, click Add New.
3. Enter the following information into the form:

l Name: hpomi
l Description: HP OMi Integration Service

4. Click Save.

Specifying connection parameters
Once you have imported the Event Domain package, you can specify the correct values for the imported Event Domain
Constants.

To specify the connection constants:

1. On the Event Domains page, in the Domains menu, click Event Domain Constants.
2. In the Event Domain drop-down list, select hpomi, and then click Continue.

l xMatters displays the pre-configured Event Domain Constants for the integration:
3. In the Event Domain Constants list, specify the correct values for the following constants (click the name of a constant

to edit its value and description):

Constant Name Default Value Description

xmattersurl http://localhost:8888 Used to specify the address of the xMatters web
server. The links provided in notification content use
the xmattersurl constant value to locate the xMatters
web server which would process the response. For
these links to work, this address must be reachable
from the Device where the User will receive the
notification; normally, this is the IP address or fully-
qualified host name of the xMatters web server.

Populates the $main.alarmpoint_url variable.

bespushurl http://localhost:8888/static Used to specify the address of the BES device server.
Populates the $main.bes_pushurl parameter.

Event Domain Constants

Note: For more information about the Event Domain Constants included in the integration and how to configure them to
suit your deployment, see "Configuring the Event Domain" on page 17.

2.2.2 Adding the Web Service User
This integration requires a Web Service User to query for events to be injected to xMatters. The following steps describe how
to configure the default Web Service User, IA_User, for this integration.
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To set up a Web Service User:

1. In xMatters, click the Users tab, and then click Find Web Service Users.
2. On the Find Web Services Users page, click All.
3. In the returned search results, locate and click IA_User.
4. On the Details for IA_User page, confirm that the list of Allowed Web Services includes the Query Incident web

service; if Query Incident is not listed in the Allowed Web Services list, select it in the Denied Web Services list, and
then click Add.

5. Click Save.

2.3 Configuring Subscriptions
The following sections describe how to manage Subscriptions in xMatters, including instructions on how to configure a
Subscription panel and assign Subscriptions to Users.

To allow Users to subscribe to specific criteria on injected events, you must configure a Subscription panel, which requires
the following steps:

n Define the Event Domain predicates
n Define a Subscription Domain
n Create a Subscription
n Create a Fail-Safe Group

2.3.1 Defining Event Domain predicates
The default integration configuration uses the following Event Domain predicates to which you can subscribe:

l SEVERITY
l PRIORITY
l STATE

These predicates are automatically created in the Event Domain when importing the Event Domain package, as described in
"Importing Event Domain and scripts" on page 7. To modify these predicates, or to add other predicates that you consider
important, see "Modifying Event Domain predicates" on page 17.

2.3.2 Defining a Subscription Domain
The Subscription Domain is the reference point for Subscriptions, and allows you to control who can create Subscriptions,
how recipients can respond to Subscription notifications, and which Event Domain predicates can be used to create a
Subscription. You must create a Subscription Domain before you can create Subscriptions.

To create a Subscription Domain:

1. On the Developer tab, the Developer menu, click Subscription Domains.
2. On the Subscription Domains page, click the Add New link.
3. In the Event Domain drop-down list, select hpomi, and then click Continue.
4. On the Subscription Domain Details page, in the Name field, type hpomi.
5. In the Type of Management drop-down list, select Both.

6. Click Continue.
7. On the Select Appropriate Response Choices page, specify the available responses for this Subscription, and then click

Continue.
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l By default, the scripts support the following response choices: “Ignore”, “Set Severity <level>” (where <level>
equals “Critical”, “Major”, “Minor", "Warning", or “Normal”), "In Progress", “Closed”, “Resolved”, and
“Annotate”. To enable two-way communications for Subscriptions, define all response choices on the Select
Appropriate Response Choices page. If you require only one-way, informational notifications, do not specify any
response choices.

8. On the Select Appropriate Predicates page, add all of the predicates to the Applied Predicates list, and then click
Continue.

9. On the Select Roles page, specify the Roles you want to be able to create Subscriptions on the Domain, and then click
Save.

Note: For more information about working with Event and Subscription Domains, see the xMatters installation and
administration guide.

Creating a Subscription
You can now subscribe to HP OMi events that match specific criteria. For example, you could configure a subscription that
would send a notification to a specific User each time an event entered the system that was of critical severity.

To create a Subscription:

1. On the Alerts tab, in the Alerts menu, click Assign Alerts.
2. Select the hpomi Subscription Domain, and click the Add New link.
3. On the Subscription Details page, specify a name for the Subscription, and set the Subscription criteria.
4. In the Recipients area, click the links to add recipients.
5. When you are satisfied with the subscription details, click Save to create the Subscription.

2.4 Configuring HP OMi
The following sections describe how to configure HP OMi to combine with xMatters.

Note: This integration requires HP OMi version 9.10 GA (with Hotfix QCCR1A130360). This hotfix resolves an issue
where HP OMi event synchronization could not synchronize event changes back into HP OMi for applications
using the event synchronization web services (this error did not apply to groovy script).

2.4.1 Creating a connected server
Configuring a connected server allows notification responses to update events appropriately.

To create a connected server:

1. In the HP OMi interface, on the Administration tab, in the Operations Management area, click Connected Servers.
2. Click the New Item icon.

l HP OMi displays the Create New Server Connection dialog box.
3. On the General page,xM in the Display Name field, type xMatters, and then click Next.
4. On the Server Type page, select External Event Processing, and then click Next.
5. On the Server Properties page, type the fully qualified DNS name of the server on which the xMatters integration agent

is installed, and then click Next.
6. On the Integration Type page, select Call External Event Web Service.
7. In the Root URL Path field, type /http/hpomi_hpomi, and then click Next.
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8. On the Outgoing Connection page, provide a username and password for the connected server.
l These values are not validated by the integration; you can use any settings provided they conform to the

minimum requirements of HP OMi.
9. Ensure that the value in the Port field (default for the integration is 8081) matches the service-gateway port defined in

the IAConfig.xml file.
10. If the integration agent and xMatters have not been configured for SSL, clear the Use Secure HTTP check box.

l For more information about secure HTTP, see "Configuring SSL" on page 25.
11. Select the Supports Synchronize and Transfer Control check box, and then click Next.
12. On the Event Drill-down page, click Next.
13. On the Incoming Connection page, enter the password specified in the omi-config.js (see "Installing the integration

service and updating the integration agent" on page 5).
14. Click Finish.

2.4.2 Creating an event forwarding rule
Each deployment of the integration requires a unique event forwarding rule, specific to each deployment, based on the
organization's assessment of which events are appropriate to be sent to xMatters. An organization can choose to have more
than one event forwarding rule, but for the integration to function correctly, an Event Forwarding rule must exist and be
associated with the xMatters connected server..

The following steps provide an example of how to create a forwarding rule; the rule required for your integration will not be
precisely the same.

To create an event forwarding rule:

1. In the HP OMi interface, click the Tune Operations Management tab drop-down list, and then click Forwarding
Rules.

2. On the Event Forwarding Rules page, click the New Item icon.
l HP OMi displays the Create New Event Forwarding Rule dialog box.

3. In the General section, in the Display Name field, type xMatters Event Forwarding Rule.
4. In the Condition section, click the Browse button beside the Event Filter drop-down list.
5. In the Select an Event Filter dialog box, click New, and then select Simple Filter.
6. In the Filter Configuration dialog box, in the Filter Display Name field, type xMatters Minor Severity Filter.
7. Select the Minor Severity check box, and then clear the check box for all other severities.
8. In the Correlation area, select All top level events, and then click OK.

l HP OMi returns you to the Select an Event Filter dialog box, with the xMatters Minor Severity Filter selected.
9. Click OK.
10. In the Target Servers drop-down list, select xMatters, and then click Add target server (the plus symbol beside the

drop-down list).
11. In the Forwarding Type drop-down list, select Synchronize.
12. Click OK.
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Chapter 3: Integration Validation
After configuring xMatters and HP OMi, you can validate that communication is properly configured. It is
recommended that you start the components in the following order:

l HP BSM Operations Manager i software
l xMatters (IT Operations) engine
l xMatters integration agent

Consult the respective user manuals for details on starting these applications.

The following sections will test the combination of xMatters and HP OMi for notification delivery and response,
and Subscription Panel functionality.

3.1 Triggering a notification
The following example illustrates how moving an event to "In Progress" will trigger a notification in xMatters.

3.1.1 Inject a sample event
You can use the packaged sendEvent.bat script to inject a test event into HP OMi.

On Windows, this script is located at:
C:\HPBSM\opr\support

For information on how to use the sendEvent.bat script, please refer to the HP OMi documentation.

3.2 Responding to a notification
This section describes how to respond to a notification from xMatters. In the following example, the notification is
received on a BlackBerry Device, but the process is similar for all Devices.

To respond to a notification:

1. When a notification arrives for the User, the Device indicates the number of calls received:
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2. Opening the notification displays its details:

3. Scrolling down will display the remainder of the details, and the list of possible replies:
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4. To respond to the notification, the User clicks a response choice, and xMatters updates the event in HP OMi.

For more information about response choices, and changing the options available to Users, see "Response choices" on page
22.

3.3 Viewing response results
When the response is received, the Lifecycle state is changed to In Progress and a message is logged in the Annotations tab
of the event.

To view the notification results:

1. Open the HP OMi Web Console.
2. On the Event Perspective tab, under Event Browser, locate the event used for testing notifications.

l The Life Cycle State has changed to In Progress, indicating that the event was acknowledged from xMatters:
3. To display the messages annotated to the event, click the Annotations tab.

l An annotation indicates that the event was changed to "In Progress" by bsmith.
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3.4 Testing the Subscription Panel
To test Subscriptions, ensure that you have created a Subscription (for more information, see "Creating a Subscription" on
page 10), and then trigger a notification that matches the criteria in our Subscription. You will receive an FYI Notification
(informational only) which will not have any response choices available.
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Chapter 4: Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend the xMatters (IT Operations)
for HP BSM Operations Manager i software integration.

4.1 Manually configuring xMatters
This integration includes an exported version of the xMatters script package and Event Domain, including Event
Domain constants and predicates. If you do not want to use the included XML file to create and configure the
required Event Domain and Action Scripts, the following sections describe how to manually configure these
components.

4.1.1 Importing the script package
This integration includes a set of customized Action Scripts specific to HP OMi that must be imported into the
xMatters scripts. The default callout scripts in a standard xMatters deployment are not configured to use web
services to annotate the originating event, and must be updated to inject messages back to the HP OMi integration
action scripts.

Note: This step requires the xMatters Developer IDE. For installation instructions and more information about
scripting in xMatters, refer to the xMatters Online Developer's Guide.

To import the xMatters Script Package:

1. Launch the xMatters Developer IDE, and then configure the database connection.
2. Click Workspace > Import.
3. Select the xM-HP-OMi\components\alarmpoint\scripts\xM-HP-OMi.aps file extracted from the

integration zip file, and then click OK.
4. When the script has finished importing, click OK.

5. Right-click the Default Company folder, and then select Validate.
6. Right-click the Default Company folder, and then select Check In.
7. In the Create Script Package dialog box, click Create., and then click Close.

4.1.2 Configuring Users
Each xMatters User that will be notified and respond to notifications must be configured to allow xMatters to
communicate with HP OMi as that User. Note that each User must also be configured in HP OMi.

To configure a User:

1. In xMatters, click the Users tab.
2. Use the Find Users page to locate the User you want to configure and view their details.
3. In the Common Tasks pane, click User Devices.
4. Verify that an appropriate Device exists and that it is enabled.
5. Click Save.

Note: If you have no Users in the system, you can use the default demonstration User, "bsmith". If this User does
not exist, create a User with the User ID “bsmith”, and add a virtual text phone Device. For more
information and instructions on how to perform these tasks, refer to the xMatters engine user guide.



xMatters (IT Operations) for HP BSM Operations Manager i software

Chapter 4: Optimizing and Extending the Integration | 17

4.1.3 Configuring the Event Domain
By default this integration is set up to use an Event Domain of “hpomi”; it is strongly recommended that you use this default
Event Domain.

The xMatters (IT Operations) engine web server must be running to perform this portion of the integration.

To define an Event Domain:

1. Log in to xMatters as a Company Administrator, and click the Developer tab.
2. In the Developer menu on the left side of the screen, click Event Domains.
3. On the Event Domains page, click Add New.
4. Enter the following information into the form:

l Name: hpomi
l Description: HP OMi Integration
l Script Package: HP Operations Manager i

5. Click Save.

Defining an Integration Service
For the installation to be successful, the integration service name must match the name specified in the hpomi.js file and
the IAConfig.xml file installed on the integration agent.

To define an Integration Service:

1. In xMatters, on the Event Domains page, click the hpomi Event Domain.
2. On the Event Domain Details page, in the Integration Services area, click Add New.
3. Enter the following information into the form:

l Name: hpomi
l Description: HP OMi Integration Service

4. Click Save

Modifying Event Domain predicates
The default integration configuration uses the following Event Domain predicates to which you can subscribe:

l SEVERITY
l PRIORITY
l STATE

These predicates are automatically created in the Event Domain when importing the Event Domain package, as described in
"Importing Event Domain and scripts" on page 7. The following instructions are included to explain how to add or modify
these predicates, and explain how the default configuration relates to event details in HP OMi.

Note: You can also use the following steps to add other predicates that you consider important and which you plan to
add to the integration as explained in "Adding new parameters" on page 21.

To define Event Domain predicates:

1. In xMatters, click the Developer tab.
2. On the Event Domains page, click hpomi.
3. On the Event Domain Details page, click Add New.
4. Add the following predicates to the Event Domain:
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Predicate Type Important Values Description

SEVERITY List Yes Manually
entered

Severity is a list predicate containing some or all of the
following values (case sensitive):

l Critical
l Major
l Minor
l Normal
l Warning
l Unknown

The items listed for Severity should be specifically chosen to
match the severity of the events forwarded from HP OMi.
Exclude any severities that will not be submitted for
notification.

This predicate corresponds to the $severity variable in HP
OMi.

PRIORITY List Yes Manually
entered

Priority is how important fixing the event is to Users. This is
in contrast to Severity, the level of which is automatically
determined by HP OMi.

Valid values for Priority are:

l highest
l high
l medium
l low
l lowest
l none

This predicate corresponds to the $priority variable in HP
OMi.

STATE List Manually
entered

State is a list predicate that describes the HP OMi Lifecycle
State of the event.

Valid values for State are:

l OPEN
l IN PROGRESS
l RESOLVED
l CLOSED

This predicate corresponds to the $state variable in HP OMi.

Event Domain predicates

Defining Event Domain Constants
Company Administrators and Developers can create Event Domain Constants that will be available in scripting for all event
objects associated with an Event Domain.This integration uses Event Domain Constants to define custom values for the
integration script package.
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The integration script package uses the names of the constants defined in the table below to look up the values; it is strongly
recommended that you use the names specified, or speak to your xMatters client assistance representative before changing
these values.

Note: The values for the alarmpointurl and bespushurl constants should be modified to specify the address of the xMatters
web server (to enable the HMTL response options) and the BES device server.

To add an Event Domain Constant:

1. In xMatters, click the Developer tab, and then, in the menu on the left side of the screen, click Event Domain
Constants.

2. In the Event Domain drop-down list, select hpomi.
3. On the Event Domain Constants page, click Add New.
4. Define a Constant Name, Value, and Description for the new constant, according to the table below.
5. Click Save.
6. Repeat the above steps for each of the constants you want to add.

l Note that if the constants are not defined in the web user interface, the scripts will use the values listed in the
Default Values column of the following table.

Note: Shaded rows indicate mandatory settings that are specific to your deployment. You must change the default settings
to match your instance.

Constant Name Default Value Description

xmattersurl http://localhost:8888 Used to specify the address of the xMatters web server. The
links provided in notification content use the alarmpointurl
constant value to locate the xMatters web server which would
process the response. For these links to work, this address must
be reachable from the Device where the User will receive the
notification; normally, this is the IP address or fully-qualified
host name of the xMatters web server.

Populates the $main.alarmpoint_url variable.

bespushurl http://localhost:8888/static Used to specify the address of the BES device server. Populates
the $main.bes_pushurl parameter.

forcefyi disable Force notifications to be informational only (FYI), rather than
requiring responses; this overrides the fyi behaviour specified on
the injected event. Possible values:

l disable: Nothing is forced.
l on: Notifications are forced to be FYI.
l off: Notifications are forced not to be FYI.

Populates the force_fyi parameter.

Event Domain Constants
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Constant Name Default Value Description

failsafegroup HP OMi Fail Safe The fail-safe recipient to notify, typically a group.

The fail-safe group identifies the recipient that will be notified if
an event is injected to xMatters (IT Operations) engine and no
subscriptions exist that match the event. Set this constant if you
want to change the failsafe group from HP OMi Fail Safe to
another group defined in xMatters.

failsafe enabled Controls fail-safe functionality, notifying the fail-safe recipient
via EMAIL under certain circumstances; possible values are:

l enabled: Notify if no subscriptions match or no notifiable
recipients.

l for-subscriptions: Notify if subscription functionality is
enabled AND no subscriptions match.

l for-recipients: Notify if no notifiable recipients.
l disabled: Disable fail-safe functionality.

Populates the $fail_safe parameter.

overridetimeframes false Override Recipients Device Timeframes.

Populates the $override_timeframes parameter.

useemergencydevices false Force the use of emergency Devices.

Populates the $use_emergency_devices parameter.

trackdelivery true Track when each device is delivered to. Setting this to false may
give a performance advantage, but you lose any information
about whether a delivery was successful or not.

Populates the $track_delivery parameter.

annotate true Enables submission of annotations back to the management
system.

Populates the $main.annotate parameter.

subscriptionannotate true Enables submission of Subscription annotations back to the
management system.

Populates the $main.subscription_annotate parameter.

tracksubscriptiondelivery true Track when each device is delivered to for Subscriptions.

Populates the $track_subscriptionDelivery parameter.

timeout 259200 Amount of time (in seconds) the event is allowed to run before
timing out. 259200 seconds = 72 hours.

Populates the $main.timeout parameter.

maxinvalidresponses 3 Specifies the maximum number of invalid responses allowed
before notification is no longer requeued.

Populates the $main.maxInvalidResponses parameter.
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Constant Name Default Value Description

enablehtmlemail true Enables HTML email functionality.

Populates the $main.enable_HTML_Email parameter.

uselogo true Set this if you want the logo displayed within HTML email
notifications.

Populates the $main.use_logo parameter.

useurlalias false Indicates how Response Choices are presented to xMatters to
ensure that the user is authenticated in the correct company so
the notification can be updated.; set to true for xMatters on
demand integrations.

debug false Indicates whether to use the debug level for logging messages.

Populates the $main.debug variable.

enablesubscriptions true Indicates whether to enable processing of Subscriptions on
incoming events.

subscriptionfyi false Indicates whether Subscriptions should be forced to be
informational only (FYI).

numericpagernumber 555-1212 The callback number to be used as the subject for outgoing
notifications to numeric pagers.

4.2 Adding new parameters
Additional data elements (or tokens) can be forwarded to xMatters by adding them in HP OMi. The following steps explain
how to add a new event token to the event injected to xMatters.

Note: For more information about which parameters may be available, refer to the HP OMi documentation.

To add an event parameter:

1. Open the <IAHOME>\integrationservices\hpomi\hpomi-request.js file.
2. To add a new child node to the generated APXML data, locate the function convertOprEventToAPXML:

function(event).
3. Locate the following comments:
// add custom tokens
// apxml.setToken("custom_token", event.custom_token);

4. Uncomment the apxml.SetToken line.
5. Save and close the file.

Note that the above token, event.custom_token, is an example. This value must be changed to a valid Opr Event type which
represents a field for an HP OMi event. A description of an Opr Event object can be found in the HP Business Service
Management Operations Manager i Extensibility Guide.

You can now use the new parameter within the Action Scripts to add content to notifications.
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4.2.1 Adding new parameters to notification content
Once you have injected the new data elements, you can add the token as a parameter to the notification content for Devices.
The following steps explain how to add the custom parameter to email notifications; adding content for other Device types is
similar and requires the presentation script to be modified for the specific Devices.

To add a new token to email notification content:

1. Open the xMatters Developer IDE and check out the HP Operations Manager i (BUSINESS) Script Package.
2. Open the PRESENTATION > deviceContentEmail script, and locate the following line:
@messageContent::put( "Duplicate Count", $event.duplicate_count )

3. Add the following below the Duplicate Count line; replace "custom_token" with the name of the custom token you
added in the previous section:

@messageContent::put( "custom_token", $event.custom_token )

4. Save, validate, and check in the script.

Your custom parameter should now appear in the notification content for email Devices. Repeat the above steps for each
Device content creation section (such as deviceContentBES for BlackBerry Devices) to which you want to add the new
parameter.

4.3 Response choices
This integration allows recipients to respond to notifications with several default choices, some of which are injected back to
the HP OMi server, updating the original event. Users notified on email Devices also have the ability to respond with an
extra annotation message which will be logged in the original event, as described in "Adding annotation messages", below.

The following is a list of the default response choices available with the integration and their associated actions on the event
in xMatters and the HP OMi event.

Response HP OMi Update xMatters Job Control

In Progress Moves the Lifecycle State of the event to "In
Progress", and annotates the event with the name of
the responder and the Device used.

Delink all except responder

Ignore Annotates the event with the name of the responder
who ignored the notification and the name of the
Device used.

Notify next, delink responder.

Resolved Moves the Lifecycle State of the event to
"Resolved", and annotates the event with the name
of the responder and the Device used.

Delink all except responder

Closed Moves the Lifecycle State of the event to "Closed",
and annotates the event with the name of the
responder and the Device used.

Delink all

Raise Severity Increases the severity of the event in HP OMi by
one level. (Voice only)

Delink all except responder

Lower Severity Decreases the severity of the event in HP OMi by
one level. (Voice only)

Delink all except responder
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Response HP OMi Update xMatters Job Control

Set Severity Critical Sets the severity of the event to critical. (Email,
BES, and browser only)

Delink all except responder

Set Severity Major Sets the severity of the event to major. (Email, BES,
and browser only)

Delink all except responder

Set Severity Minor Sets the severity of the event to minor. (Email, BES,
and browser only)

Delink all except responder

Set Severity Warning Sets the severity of the event to warning. (Email,
BES, and browser only)

Delink all except responder

Set Severity Normal Sets the severity of the event to normal. (Email,
BES, and browser only)

Delink all except responder

Annotate Allows the User to append a message to the
annotation tab of the event in HP OMi. (Non-
HTML Email only)

Delink all except responder

Job control definitions
The xMatters job controls in the above table are defined as follows:

l Delivered: marks the notification as delivered.
l Notify next: notifies the next recipient in the Group according to the defined escalation in xMatters.
l Delink responder: marks the notification as delivered, and stops the responder from performing any further action on

the notification.
l Delink all except responder: marks the notification as delivered, and stops any recipients other than the responder from

performing any further action on the notification.
l Delink all: marks the notification as delivered, stops any further action on the notification for all recipients, and

terminates the event in xMatters.

The job control defined for each response choice is the default configuration for this integration; for more information about
job control, and how to modify these actions in the scripts, see the xMatters Online Developer's Guide.

4.3.1 Adding annotation messages
Two-way email Device notifications (not FYI) can add extra annotations that will be added to the HP OMi event as a
message on the Annotations tab. To add an extra annotation, respond to an email notification with the following format in
the subject line:
RESPONSE <Choice> <Message>

<Choice> can be any of the response choices listed in the table above, and <Message> can be any content you want to add
as the annotation.

4.3.2 Changing and adding response choices
Changing or adding a response choice to the integration requires the following steps:

l Add or modify the response choice on the Subscription Domain (as described in "Defining a Subscription Domain" on
page 9).

l Update the xMatters script to forward the response choice to the integration agent.
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l Update the integration agent to send the response choice into HP OMi to perform the desired action on the originating
event.

As an example, the following code illustrates adding a response choice of "Be there in 10 minutes" to the integration:

To forward the response choice to the integration agent, launch the xMatters Developer IDE and open the Handler script;
make the following changes:

1. In the buildUserResponseMap script add:
@userResponseMap::put("be there in ten minutes", "be there in ten minutes")

2. In the processUserResponse script add:
IF ( $actionToken == "be there in ten minutes" )
GOSUB prepareAndSendServiceMessage

CALL sendAPDeliveredResponse

To send the response choice from the integration agent into HP OMi, open the hpomi.js file, and add a new ELSE-
IF statement to the handleApsResponses function:
if ( responseAction.equalsIgnoreCase( "be there in ten minutes" ) )
{
// Implement functionality to send a web service request to OMi
log.debug("About to start 'be there in ten minutes functionality');

<your code goes here>
}

The above is intended only as a brief overview of the required components. For more information about responses and
scripting, refer to the xMatters Action Scripts and the xMatters Online Developer's Guide.

4.3.3 Responses for FYI notifications
FYI notifications do not have any response choices available, except for FYI notifications sent to voice Devices. Voice FYI
notifications offer the following response choices so that Users can navigate between multiple notifications. (This navigation
is not required on other Devices.)

Response Description

Delete Removes the notification from the User’s list. This option is most likely to be selected.

Save Saves the notification and stops attempting to deliver it to the User’s other Devices. Users may select this
option to delay listening to the notification when it is delivered, and access the details by calling in, or via the
xMatters web user interface, at a later time.

Repeat Replays the notification content.

Voice Device responses for FYI notifications

4.4 Annotations
This integration extensively annotates the originating HP OMi event with messages regarding the delivery status of
notifications from xMatters, but this may not be desirable in all environments. To prevent annotations, change the value of
the ANNOTATE_DELIVERY variable in omi-config.js to false..
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4.5 Altering the duration of events
You can modify the amount of time xMatters will send out notifications for a particular event before it times out by changing
the "timeout" Event Domain Constant. This constant stores the number of seconds the notifications will be allowed to
continue before timing out.

For example, if you wanted to change the event duration to two hours, you could change the value for the timeout constant
to 7200.

Note: For more information about working with Event Domain Constants, see "Configuring the Event Domain" on page
17.

4.6 Filtering and suppression
The xMatters integration agent's Portable Filtering and Suppression Module is a built-in module that maintains a rolling
record of previously injected events, and allows for the suppression of duplicates (also referred to as "deduplication"). This
helps avoid disruption of traffic due to inadvertent loads that can result when, for example, improperly configured
management systems inject duplicated events.

The deduplicator-filter.xml file is installed in the <IAHOME>\conf folder and is configured to suppress duplicate events
for 12 hours (up to a maximum of 100 events in that period).

This filter can be modified to extend the time period over which an event is considered to be a duplicate, the number of
events in that period and the tokens that are used to determine what makes the event unique.

For example, to add category to the tokens, open the deduplicator-filter.xml file in a text editor and add the following
line to the <predicates> collection:
<predicate>category</predicate>

Save the file and restart the integration agent for the changes to take effect.

Note: To see a complete list of predicates available in the integration, reviewing the Event Data in the Event Summary
Report in the xMatters web user interface.

4.7 Configuring SSL
This integration supports SSL communication between the integration agent and HP OMi and between the integration agent
and xMatters.

4.7.1 Using self-signed certificates
The SSL support has been configured out of the box to support self-signed certificates. This is not recommended for
production systems due to security reasons, unless you are aware and accepting of the security implications of self-signed
certificates.

To modify the SSL configuration:

1. Open the <IAHOME>\integrationservices\hpomi\wsutil.js file and modify the ACCEPT_ANY_CERTIFICATE
variable as follows:

l Set to true to use SSL but trust any certificate (including self-signed ones).
l Set to false to accept only Certificate Authority (CA) certified certificates (recommended in production

environments).
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4.7.2 Importing certificates
The next step required to enable SSL support is to import the certificate used by the HP OMi web server to the cacerts
keystore of the Java Virtual Machine (JVM) bundled with the integration agent.

Using the keytool executable located at <IAHOME>\jre\bin, execute the following command on the integration agent to
import the certificate, replacing the variables with the appropriate values as described in the list below:
keytool -import -alias <your.alias> -file <path>/<certificate>.cer -keystore
<dir>/jre/lib/security/cacerts -storepass <password>

l <your.alias>: an identifier for the certificate within the keystore; for example, you can use the string "hpomi".
l <path>: path to the certificate
l <certificate>: the certificate’s file name
l <dir>: the directory in which the integration agent is installed.
l <password>: the password for the cacerts keystore; the default password is "changeit".

If you want to configure SSL support between the integration agent and xMatters, use the above command to import the
trusted certificate for xMatters into the integration agent keystore (for information on setting up SSL in xMatters, consult the
xMatters Community site at http://community.xMatters.com

4.7.3 Updating HTTP to HTTPS
The next step is to update the OMI_PROTOCOL in the <IAHOME>\integrationservices\hpomi\omi-config.js file to
use the HTTPS protocol instead of HTTP.

The modified value should resemble the following:
var OMI_PROTOCOL = "https";

Note: For trusted certificates, "localhost" should be replaced with the COMMON NAME (CN) specified in the certificate
and the port should be set to the port specified in the SSL configuration for HP OMi.

To configure the integration agent to use HTTPS when communicating with xMatters:

1. In a text editor, open the <IAHOME>\conf\IAConfig.xml file.
2. Modify the URL for the <primary-servers> and <secondary-servers> elements to use the HTTPS protocol instead of

HTTP; the section should resemble the following:
<primary-servers>
<!--
| 0 or more URL elements that specify the primary location of each xMatters server's
| RegisterIntegrationAgent Web Service. The URLs must begin with either http:// or https://
| and cannot have a query or fragment component. The URLs must be resolvable from this IA.
+-->
<url>https://localhost:8443/api/services/AlarmPointWebService</url>
</primary-servers>

<!--
| These servers are assumed to be connected to the same xMatters database,
| which can be different than the primary servers' database.
+-->
<secondary-servers>
<!--
| 0 or more URL elements that specify the secondary location of each xMatters server's
| RegisterIntegrationAgent Web Service. The URLs must begin with either http:// or https://
| and cannot have a query or fragment component. The URLs must be resolvable from this IA.
+-->
<url>https://localhost:8443/api/services/AlarmPointWebService</url>
</secondary-servers>
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Note: For trusted certificates, "localhost" should be replaced with the COMMON NAME (CN) specified in the certificate
and the port should be set to the port specified in the SSL configuration for the xMatters server.

3. Modify the value for the <service-gateway> element to use SSL; note that the service-gateway host IP must be
resolvable from the xMatters servers:

<service-gateway ssl="true" host="localhost" port="8081"/>

4. Restart the integration agent.

4.7.4 Optional Configuration
The following scenarios illustrate the common configuration options available when using SSL.

Scenario 1
l HP OMi certificate: CA-certified
l xMatters certificate: CA-certified

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to false.

This will ensure ALL communication between the integration agent and HP OMi and the integration agent and xMatters uses
the appropriate CA certified certificates

Scenario 2
l HP OMi certificate: CA-certified
l xMatters certificate: self-signed

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to false.

In xmatterws.js, add the following line at the end of the init() method:
this.ACCEPT_ANY_CERTIFICATE = true;

This will allow communication between the integration agent and xMatters to use self-signed certificates while maintaining
more complete security between the integration agent and HP OMi.

Scenario 3
l HP OMi certificate: self-signed
l xMatters certificate: CA-certified

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to true.

In xmatterws.js, add the following line at the end of the init() method:
this.ACCEPT_ANY_CERTIFICATE = false;

This will allow communication between the integration agent and HP OMi to use self-signed certificates while maintaining
more complete security between the integration agent and xMatters.

Scenario 4
l HP OMi certificate: self-signed
l xMatters certificate: self-signed

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to true.

This will allow ALL communication between the integration agent and HP OMi and between the integration agent and
xMatters to use self-signed certificates.



xMatters (IT Operations) for HP BSM Operations Manager i software

Chapter 4: Optimizing and Extending the Integration | 28

4.8 Troubleshooting
This section identifies and explains some issues with the integration that may be encountered during installation,
configuration, or validation.

4.8.1 Voice files
Note that on multiple-Company deployments, the voice files must be installed to <xMHOME>\node\phone-
engine\Datastore\<company_id>\common\recordings\english\phrases, where <company_id> is the database
identifier of the Company where the hpomi Event Domain has been created.

If the voice files have already been copied to the above location, but are still not playing in notifications, you can copy the
voice files to the global location at <xMHOME>\node\phone-engine\Datastore\global\common\
recordings\english\phrases. Note that this is the location for the out-of-box voice files; adding the integration specific
files to this location may cause them to be played for notifications not related to HP OMi.

4.9 Uninstalling
For instructions on removing an xMatters deployment, refer to the xMatters installation and administration guide.
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Chapter 5: Configuration Variable Reference
This section outlines and describes the configuration variables available in the initial PROCESS Action Script.

Note that many of the configuration variables are configurable using the Event Domain Constants, as described in
"Configuring the Event Domain" on page 17; those variables are not listed here.

5.1 Global configuration variables
These variables are available throughout the script package, and are parameters of the “main” object. The value
assigned to each variable is its default value within the script.

Variable Description

$main.use_logFile = false Specify whether to use an alternate log file for debugging
messages. This variable is ignored unless $main.debug is
also set to true.

$main.logFile = "../logs/" Defines the file used to log debugging information (only
if $main.use_logfile is set to true).

$main.HTML_form_url = $AlarmPoint_URL &
"/jsp/ProcessNotificationResponse.jsp"

Specifies the URL of the xMatters web server’s Process
Notification Response JSP form, used by HTML email and
BES to inject responses through the system.

$main.logo = $AlarmPoint_URL &
"/static/images/logos/alarmpoint/UNKNOWN.png"

Specifies the path to the graphic displayed on HTML
(email and BES) notifications.

$main.logo_alt_text = “[If the logo does not appear
you may be blocking images or you may be outside
a firewall. If the latter, the links will not work for
responding and you should respond by replying to
this email as described below.]”

The alternate text to display if the HTML email logo is
unavailable.

Note: If the logo does not display, it is unlikely that the
HTML_form_url is valid and responses will not be
injected from HTML Devices (email and BES).

Gobal variables
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